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Overview

An overview of the Sybase® CEP Studio.

Sybase CEP Studio Overview
Sybase CEP Studio is the graphical application component of Sybase CEP Engine that enables
the developing, compiling, and running of Sybase CEP projects. While Sybase CEP Studio is
most often used to develop and test Sybase CEP applications, you can also use it to run
production applications.

Many of the actions performed using the Sybase CEP Studio interface modify the project's
CCL code. This same result can be achieved by manually editing the code.

Use Sybase CEP Server in conjunction with a tool that compiles, loads, starts, stops, and
executes projects. Besides Sybase CEP Studio, you can also use the Sybase CEP Eclipse
Plug-In or the command-line tools c8_compiler and c8_client. See the Sybase CEP Eclipse
Plug-In Guide and the Sybase CEP Integration Guide for more information about these tools.

The Sybase CEP Getting Started Guide tutorial includes exercises you can complete to
become familiar with Sybase CEP Studio and general Sybase CEP Engine concepts.

Sybase CEP Studio and Sybase CEP Server
Use Sybase CEP Studio to edit the source code of a Sybase CEP project, compile it with the
Sybase CEP compiler, and send the results to Sybase CEP Server for execution.

Sybase CEP Server executes a project in a specific Workspace, an autonomous processing
area.

A Sybase CEP Studio Environment provides a view into one or more Workspaces on Sybase
CEP Server. Multiple Environments can contain views into the same Workspace.

The following diagram illustrates the relationship between Sybase CEP Studio Environments
and Sybase CEP Server Workspaces:

Overview
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In Sybase CEP Studio, you connect to a Workspace, which allows you to interact with it.

When you use Sybase CEP Studio to load a project, it makes the source code available for
editing and compiling. It also associates the project with a Workspace on Sybase CEP Server
temporarily, although a single project can be loaded into different Workspaces at different
times, or even simultaneously loaded into the same Workspace under different names.

When using Sybase CEP Studio to run a project, the Studio first calls the Sybase CEP compiler
to compile the CCL code and then sends the result to Sybase CEP Server for execution in a
particular Workspace.

The following diagram illustrates loading, compiling, and running Sybase CEP Projects:

Note that Sybase CEP Studio and the Sybase CEP compiler must have access to the files
containing a project's CCL source code, while Sybase CEP Server uses only the compiled
code (contained in .ccx files). You must explicitly stop a running project. Exiting Sybase CEP
Studio has no effect on projects running on Sybase CEP Server.

Overview
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Downloading Sybase CEP Studio
A description of the steps required to download Sybase CEP Studio from the Sybase CEP
website.

1. Open a Web browser and go to the Sybase CEP Web site at www.sybase.com.

2. On the Developers menu, click Download.

3. Find the version of operating system you are using in the list of supported platforms and
versions.

4. Click the link to the right of the listing for Sybase CEP Studio under the appropriate
platform.

5. Follow the displayed instructions to log in and save the downloaded file.

Installing Sybase CEP Studio

Follow these steps to install Sybase CEP Studio:

1. If you are installing Sybase CEP Studio on Microsoft Windows Vista, make sure that you
are logged in as administrator.

2. Locate the Sybase CEP Studio installation file you downloaded from the Sybase CEP Web
site on your computer and then open it to start the Sybase CEP Studio Setup Wizard.

3. Complete the Sybase CEP Studio Setup Wizard, accepting the default setup options that
are offered on each page, unless you have been advised by your System Administrator to
specify other options.

4. On the last page of the Sybase CEP Studio Setup Wizard, check the “Run Sybase CEP
Studio version” check box. This option starts Sybase CEP Studio immediately after you
complete the wizard.

Next

See the Sybase CEP Installation Guide for more information about the available installation
options, as well as instructions for installing Sybase CEP Studio on UNIX-like operating
systems.

Overview
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Project Components and Data Flow
Sybase CEP projects are made up of one or more discrete units called query modules. Every
project contains one main query module, represented in Sybase CEP Studio by the same icon
as the project.

Creating a project automatically creates the main query module. Likewise, loading,
unloading, compiling, and running a project automatically loads, unloads, compiles, or runs
the main query module.

You can define other, nested, query modules, called submodules, within a main query module.
When you compile and run a project, you compile and run the submodules.

Query modules include groups of CCL statements (sometimes called queries) that process
data, data streams that carry data, formatted into rows and columns, through Sybase CEP
Engine, adapters that translate data to or from a format compatible with Sybase CEP Engine,
and windows that retain rows until a specified count or period of time is reached.

The following diagram illustrates the components of a Sybase CEP project and how data
typically flows through Sybase CEP Engine:

Data typically flows through Sybase CEP Engine as follows:

1. Data enters Sybase CEP Engine from an external source through an input adapter, which
converts data into a Sybase CEP-compatible format and publishes it to an input stream.

2. Queries run continuously, subscribe to input streams, process the incoming rows, and
publish rows to output streams.

3. An output adapter converts the data into a format suitable for its external destination.

A few more details about data streams:

• Input: Streams receive data from outside the current query module, either through input
adapters as shown in the diagram, or through bindings to streams in other modules. Input
streams cannot be used as the destination for CCL statements as you cannot send data to an
input stream with a query.

Overview
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• Output: Streams send data to destinations outside the current query module, either through
output adapters as shown in the diagram, or through bindings to streams in other modules.

• Local: Streams carry data solely within the current query module. They cannot be
connected to input or output adapters, and they can only be bound to input and output
streams in the query module's submodules. They cannot connect to streams outside the
current project.

For more information about these components and how to work with them in CCL, see the
Sybase CEP CCL Reference Guide.

Overview
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User Interface

An overview of the CEP Studio user interface, including windows, menus, toolbars, views,
and viewers.

Sybase CEP Studio Interface
An illustration of the Sybase CEP Studio user interface.

Sybase CEP Studio Main Window
A description of how to modify views in the main Sybase CEP Studio window.

The following illustration shows Sybase CEP Studio with the default views displayed and
docked in their default locations.

The following list provides links to additional information about the components of the main
Sybase CEP Studio window:

User Interface
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File Menu on page 10

Edit Menu on page 11

View Menu on page 12

Project Menu on page 13

Debug Menu on page 14

Tools Menu on page 16

Help Menu on page 16

Module Toolbar on page 18

Editor Toolbar on page 18

Compile Toolbar on page 18

Stream Viewer Toolbar on page 19

Explorer View on page 20

Editor View on page 20

Properties View on page 21

Flow View on page 30

Output View on page 32

Flow View Toolbar on page 19

Display or hide a view by clicking the name of the view on the View menu.

Display or hide a toolbar by pointing to Toolbars on the View menu and then clicking the name
of the toolbar.

Move views by dragging their title bars and toolbars by dragging their handles. Sybase CEP
Studio remembers the location of your views and toolbars across sessions. Hold the Control
key while dragging a view to dock it in the main Sybase CEP Studio window.

To restore the views and toolbars to their original locations, click Restore Default Layout on
the View menu.

User Interface
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Status View Layout
When you run a project, the default layout includes the Status view instead of the Properties
view.

User Interface

Studio Guide    9



Stream or Window Viewer
A stream or window viewer, which displays the contents of a stream or named window, opens
as a separate window.

The following list provides links to additional information about the components of a stream
or window viewer:

Stream or Window Viewer Toolbar on page 19

Filtering Data in a Viewer on page 32

Menus
A description of functions you can access from the various menus of Sybase CEP Studio.

File Menu
A description of functions you can access from the File Menu in Sybase CEP Studio.

New Project
Creates a new project and loads it into the selected Workspace,
placing the files in the location you specify.

Load Project

Loads an existing project from the file you specify into the selected
Workspace. Once loaded, you can temporarily change the name of
the project by clicking Rename on the shortcut menu. This allows
you to load multiple instances of the same project.

User Interface
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Reload Project

Identifies the source files for a previously loaded project that Syb-
ase CEP Studio cannot locate for some reason. The icon in the
Explorer view appears dimmed for such a project before you re-
load it.

Unload Project Unloads a project from a Workspace.

Unload Multiple Projects Unloads several projects at once from a Workspace.

Import BPEL File
Runs the BPEL to CCL Wizard, which translates a BPEL file and a
Sybase CEP schema file into a CCL query module for monitoring
BPEL business processes.

Export to a Zip File

Starting with the directory containing the specified project file,
creates a Zip file containing the entire tree. If the project is under
the SybaseC8Repository, then the archive reflects the project di-
rectory path under the SybaseC8Repository; otherwise the archive
contains the directory tree without a preceding path.

Connect to Workspace
Connects to an existing Workspace or creates a new Workspace on
Sybase CEP Server.

Reconnect Workspace Attempts to reconnect to a Workspace .

Disconnect Workspace Disconnects from the specified Workspace .

Environment

New: Closes the current Environment, and opens the New Envi-
ronment dialog box, where you can create a new Environment.

Open: Closes the current Environment, and opens the Open En-
vironment dialog box, from which you can open an existing En-
vironment.

Close: Closes the current Environment.

Page Setup Sets up the format for printing the contents of the Queries tab.

Print Prints the contents of the Queries tab.

Recent Projects
Shows a list of up to nine recently opened projects that you can
click to open.

Recent Workspaces
Shows a list of up to nine recently connected Workspaces that you
can click to connect.

Exit Exits Sybase CEP Studio.

Edit Menu
A description of functions you can access from the Edit Menu in Sybase CEP Studio.

The Edit menu commands affect the text in the Queries tab of the Editor view.

User Interface
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Undo
Undoes edits starting from the most recent and proceeding back-
ward.

Redo
Recreates the actions you undid with the Undo command, start-
ing with the last Undo, and proceeding backward.

Cut Cuts selected text to the clipboard.

Copy Copies selected text to the clipboard.

Paste Pastes text from the clipboard.

Delete Deletes the selected text without copying it to the clipboard.

Find Searches for specified text in the Queries tab.

Replace Searches for specified text in the Queries tab and replaces it.

Select All Selects the entire contents of the Queries tab.

Comment Selection Converts the selected lines in the Queries tab to comments.

Uncomment Selection
Converts the selected lines in the Queries tab from comments to
text.

View Menu
A description of functions you can access from the View Menu in Sybase CEP Studio.

Go to Parent Module Transfers the focus from a submodule to its parent module.

Zoom in Flow View Zooms in to the Flow view diagram.

Zoom out Flow View Zooms out of the Flow view diagram.

Center Flow View
Centers the Flow view diagram and resizes it to fit in the win-
dow.

Show Selected in Flow View
Centers the diagram around the selected component, if the
component is outside the frame of the window.

Automatic Flow View Layout Resets the Flow view diagram to its default layout.

Show Runtime Information
In the Flow view, displays or hides the number of rows pro-
cessed by CCL statements. See Viewing Project Data Flow in
the Flow View on page 30.

Explorer View Displays or hides the Explorer view on page 20.

Output View Displays or hides the Output view on page 32.

Flow View Displays or hides the Flow view on page 30.
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Properties View Displays or hides the Properties view on page 21.

Status View Displays or hides the Status view on page 28.

Toolbars

Module: Displays or hides the Module toolbar on page 18.

Editor: Displays or hides the Editor toolbar on page 18.

Compile: Displays or hides the Compile toolbar on page
18.

Stream Viewer: Displays or hides the Stream Viewer toolbar
on page 19.

Restore Default Layout Restores views and toolbars to their default positions.

Project Menu
A description of functions you can access from the Project Menu in Sybase CEP Studio.

Compile
Compiles the selected project and all of its modules, if needed, without
running it. Any error messages appear in the Output view on page
32.

Compiler Options
Allows you to set compiler options for the selected module. See 
Compiler Options on page 39.

Module Enabled

Enables or disables the selected query module. Allows you to prevent a
module from being compiled or run as part of the project without
completely unloading it. The name of a disabled module appears in
italics in the Explorer view.

New Query Module Creates a new submodule of the selected module.

Load Query Module
Loads an existing query module as a submodule of the selected mod-
ule.

Reload Query Module
Identifies the source files for a previously loaded module that Sybase
CEP Studio cannot locate for some reason. The icon in the Explorer
view appears dimmed for such a module before you reload it.

Unload Query Module Unloads a query module.

Open Query Module with
Allows you to view the query module in another program, either the
default XML viewer (as specified in the External Tools settings on
page 37) or a program that you specify.

Add Input Stream Adds an input data stream to the selected module.

Add Output Stream Adds an output data stream to the selected module.

Add Local Stream Adds a local data stream to the selected module.

Convert Stream to Converts the selected stream to another type (local, input, or output).

User Interface
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Delete Stream Deletes the selected stream.

Add Schema

Adds a schema named MySchema with a single column of type String
named ColumnName. Modify the schema either by editing the CCL
code directly or using the Schema Editor in the Properties on page 27
tab.

Add Window

Adds a window named MyWindow with a schema containing single
column of type String named ColumnName and the window policy
KEEP LAST. Modify the window and its schema either by editing the
CCL code directly or using the Properties on page 27 tab and Sche-
ma on page 26 tab.

Add Parameter
Adds a parameter of type String named MyParameter. Modify the
parameter either by editing the CCL code directly or using the Pa-
rameters on page 25 tab.

Attach Input Adapter

Attaches an input adapter to the selected data stream. Input adapters
translate data from an external source to a format usable by Sybase
CEP Engine. If the adapters supplied by Sybase CEP don't fit your
needs, you can write your own. See the Sybase CEP Integration Guide
for more information.

Attach Output Adapter

Attaches an output adapter to the selected data stream. Output adapters
translate data from Sybase CEP Engine to an external source. If the
adapters supplied by Sybase CEP don't fit your needs, you can write
your own. See the Sybase CEP Integration Guide for more informa-
tion.

Remove Adapter Removes the selected adapter.

Debug Menu
A description of functions you can access from the Debug Menu in Sybase CEP Studio.

Start
Compiles and runs the selected project. The project is only
compiled if it is new or has been changed since the last com-
pile.

Start with Clean Slate

Starts the selected project without recovering persisted data.
The project starts as if it were being run for the first time,
without recovering partially processed rows, or window,
adapter, and CCL state. Only meaningful for a project with
persistence enabled for at least one module.

Restart Stops and restarts the selected project.

Stop Stops the selected project.

Start Multiple
Compiles and runs several projects at once. Projects are only
compiled if they are new or have been changed since the last
compile.
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Start Multiple with Clean Slate

Starts several projects at once without recovering persisted
data. The projects start as if they were being run for the first
time, without recovering partially processed rows, or win-
dow, adapter, and CCL state. Only meaningful for projects
with persistence enabled for at least one module.

Restart Multiple Stops and restarts several projects at once.

Stop Multiple Stops several projects at once.

Step Forward

Highlights all rows in all open stream and window viewers,
with a timestamp that falls between the timestamp of the
selected row and that of the next subsequent row. See Using
Viewers to Debug an Application on page 34.

Step Backward

Highlights all rows in all open stream and window viewers,
with a timestamp that falls between the timestamp of the
selected row and that of the closest previous row. See Using
Viewers to Debug an Application on page 34.

View Stream 'Name' Opens a viewer for the selected data stream or window.

View Stream

Opens a viewer for the data stream you identify by URI (the
Properties view displays the URI of a selected stream). You
can specify filter columns or a filter expression on page 32
to restrict the rows reaching the viewer.

View Multiple Streams in Module
'Name'

Opens viewers for multiple, specified data streams in the
current module and its submodules.

View All Streams in Module 'Name'
Opens viewers for all data streams in the selected query
module, but not its submodules.

View Multiple Named Windows in
Module 'Name'

Opens viewers for specific named windows in the current
module and its submodules. You must have set the Compiler
Mode on the Compile toolbar on page 18 to Debug.

View All Named Windows in Mod-
ule 'Name'

Opens viewers for all named windows in the selected query
module, but not its submodules. You must have set the Com-
piler Mode on the Compile toolbar on page 18 to Debug.

Clear All Viewers Clears all open viewers.

Close All Viewers Closes all open viewers.

Show All Viewers Brings all open viewers to the foreground.

Arrange All Viewers
Arranges all open viewers on the screen so that each is visi-
ble.

Reconnect All Viewers
Restarts the scrolling data display for all open viewers, after
the display has been paused.

Disconnect All Viewers Pauses the scrolling data display for all open viewers.

User Interface
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Query Public Windows in Module
'Name'

Allows you to run a SQL query against a public window in a
running project. For instructions on creating public win-
dows, see "CREATE WINDOW Statement" in the CCL
Reference Guide. Sybase CEP SQL syntax is described in
"CEP SQL" in the CCL Reference Guide.

Send Rows
Allows you to send one or more rows into an external input
stream identified by URI.

Request Workspace Status and
Open With

Allows you to view the Workspace status, either with the
default XML viewer (as specified in Sybase CEP Studio
Settings on page 37) or with the program you specify.

Open Workspace Status Stream

Opens a stream viewer for the status stream for the selected
Workspace. For a description of the messages displayed in
the viewer, see "Sybase CEP Server Events" in the Sybase
CEP Installation Guide.

Tools Menu
A description of functions you can access from the Tools Menu in Sybase CEP Studio.

CCS File Editor
Allows you to create or modify schema files. The interface is
the same as on the Schema tab on page 26 of the Properties
view for a data stream.

Workspaces Manager Allows you to create, connect to, and destroy Workspaces.

Import Adapter Definition

Imports an adapter definition into the list of available adapt-
ers. For use with an adapter you have written yourself or
purchased from a third party. See the Sybase CEP Integration
Guide for more information about writing adapters.

Local Time Calculator
Converts a timestamp expressed in number of microseconds
since the epoch into a readable format, adjusted for the local
time zone.

Settings

Allows you to set general Sybase CEP Studio options. See 
Sybase CEP Studio Settings: External Tools Tab on page
37, Sybase CEP Studio Settings: General Tab on page 37,
Sybase CEP Studio Settings: Query Editor Tab on page 38,
and Sybase CEP Studio Settings: Stream Viewer Tab on page
38.

Help Menu
A description of features you can access from the Help Menu in Sybase CEP Studio.

Get Help
Opens a browser window displaying the Sybase CEP docu-
mentation section relevant to the active Sybase CEP Studio
component.
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Online Help & Documentation
Opens a browser window displaying the documentation page
of the Sybase Web site.

Contact Sybase CEP Support

Creates a Zip file containing the selected project's files and
then opens a browser window to the Support page of the
Sybase Web site, where you can submit the Zip file along with
your question.

Contents
Opens a browser window displaying the Sybase CEP docu-
mentation.

Individual document names
Opens a browser window displaying the specified area of the
Sybase CEP documentation.

Sybase CEP News
Opens a window displaying the latest information from Syb-
ase CEP.

About Sybase CEP Studio
Opens a window displaying version and copyright informa-
tion about Sybase CEP Studio.

Shortcut Menu
A description of functions you can access from the Shortcut Menu in Sybase CEP Studio.

The following table describes commands that are only available from the shortcut menu:

Clear
In the Status view, clears the history of a monitor graph.

In a stream or window viewer, clears the display.

Copy
In a stream or window viewer, copies the selected rows, along with the column
names, to the clipboard.

Select All In a stream or window viewer, selects all the rows displayed in the viewer.

Rename
Renames the selected environment, project, query module, data stream, or
adapter.

Show value
In a stream or window viewer, copies the contents of a String or XML column
from the selected row into the default CSV file editor.

Toolbars
A description of functions you can access from various toolbars in Sybase CEP Studio.

User Interface
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Module Toolbar
A description of functions you can access from the Module Toolbar in Sybase CEP Studio.

Button
Menu
Com-
mand

Description

New Project
File >
New
Project

Creates a new project in the selected Workspace.

Load Project
File >
Load
Project

Loads an existing project into the selected Workspace.

View Project Status
View >
Status
View

Displays the Status view on page 28 if it is hidden.

Editor Toolbar
A description of functions you can access from the Editor Toolbar in Sybase CEP Studio.

Cut Cuts selected text to the clipboard.

Copy Copies selected text to the clipboard.

Paste Pastes text from the clipboard.

Comment Selection Converts the selected lines to comments.

Uncomment Selection Converts the selected lines from comments to text.

Compile Toolbar
A description of functions you can access from the Compile Toolbar in Sybase CEP Studio.

Button
Menu
Com-
mand

Description

Debug/Release
Project >
Compiler
Options

Sets the selected project to Release or Debug mode. See 
Compiler Options on page 39.

Compile
Project >
Compile

Compiles the selected project without running it.

Start
Debug >
Start

Compiles and runs the selected project.
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Restart
Debug >
Restart

Stops and restarts the selected project.

Stop
Debug >
Stop

Stops the selected project.

Stream Viewer Toolbar
A description of functions you can access from the Stream Viewer Toolbar in Sybase CEP
Studio.

Button Debug Menu Command Description

View Stream View Stream 'name'
Opens a viewer for the selected stream or
named window.

Clear All Viewers Clear All Viewers Clears all the open viewers.

Close All Viewers Close All Viewers Closes all the open viewers.

Flow View Toolbar
A description of functions you can access from the Flow View Toolbar in Sybase CEP Studio.

Button View Menu Command Description

Go to Parent Module Go to Parent Module
Transfers the focus from submodule to
parent module.

Zoom in Zoom in Flow View Zooms into the Flow view.

Zoom out Zoom out Flow View Zooms out of the Flow view.

Center Center Flow View
Centers the Flow view diagram and
resizes it to fit in the window.

Show Selected Show Selected in Flow View
Centers the selected component in the
window, if it is outside the frame.

Automatic Layout Automatic Flow View Layout
Resets the layout in the Flow view to
its default setting.

Stream or Window Viewer Toolbar
A description of functions you can access from the Stream or Window Viewer Toolbar in
Sybase CEP Studio.

Button Debug Menu Command Description

Reconnect All
Viewers

Reconnect All Viewers
Starts or restarts the scrolling data stream display
for all open viewers.
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Disconnect All
Viewers

Disconnect All Viewers
Stops the scrolling data stream display for all
open viewers.

Find N/A
Searches for the occurrence of specific data in the
viewer. See Searching for Data in a Viewer on
page 34.

Step Backward Step Backward

In all open viewers, highlights all rows with a
timestamp that falls between the timestamp of
the selected row and that of the previous row in
this viewer. See Using Viewers to Debug an Ap-
plication on page 34.

Step Forward Step Forward

In all open viewers, highlights all rows with a
timestamp that falls between the timestamp of
the selected row and that of the subsequent row in
this viewer. See Using Viewers to Debug an Ap-
plication on page 34.

Views
A description of the various views in Sybase CEP Studio.

Explorer View
A description of the Explorer view in Sybase CEP Studio.

The Explorer view contains two tabs:
• The Projects tab displays Environments, Workspaces, projects, query modules, data

streams, and adapters. Note that the icon for a project changes based on whether or not it is
running and whether or not the project contains errors or encountered run-time problems.

• The Servers tab displays the active Environment, connected Workspaces, associated
servers and server status.

Use the Explorer view to select and perform actions on Sybase CEP Studio objects, and to
view the relationships between them.

Editor View
The Editor view contains the Queries tab, which shows the CCL statements associated with
the current query module. You can add and modify CCL statements in this view.

When you select a component in the Explorer view, Sybase CEP Studio highlights the CCL
statement defining the component (if one exists) with a green bar in the margin next to the CCL
statement. Likewise, when you select the statement in the Editor view, the corresponding
component (if one exists) is highlighted in the Explorer view and Flow view.

CCL statements continually make changes to and analyze data received by Sybase CEP
Engine, as long as the project in which they are contained is running. Each Query module can
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contain multiple statements, all of which run when the project is started. For a full discussion
of CCL statements and syntax, see the Sybase CEP Programmer's Guide and the Sybase CEP
CCL Reference.

Tip: You can view the relevant section of the Sybase CEP CCL Reference by clicking a CCL
statement in the Queries tab and then pressing F1.

See Editor Toolbar on page 18 and Edit Menu on page 11 for information about the commands
you can use in the Editor view.

Properties View
The Properties view displays details about the object currently selected in the Explorer view or
the Queries tab and may enable you to perform actions on that object.

By default, the Properties view is hidden when a project is running. Information in the
Properties view is arranged in tabs that vary depending on the type of object you have selected:

• Environment: A single tab displaying the name of the Environment.
• Workspace: A single tab displaying information about the instance of Sybase CEP Server

that this Sybase CEP Studio is communicating with, including the Sybase CEP Server
URI, software version, connection status, and license details.

• Server: A Properties tab showing the same information as for a Workspace, and a Status on
page 21 tab with additional information.

• Project or Query Module: Three tabs allowing you to view and set module Properties, 
Parameters on page 25, and Bindings on page 25.

• Stream: Properties and Schema on page 26 tabs.
• Window: Properties and Schema on page 26 tabs.
• Schema on page 27: A single tab that allows you to modify the schema.
• Adapter on page 28: A single tab that allows you to set parameters specific to the adapter.

Displaying the Sybase CEP server status
The Status tab shows Sybase CEP Server settings and performance. The information
displayed on this tab is related to the Container process on which the project is running.

For more information about Manager and Container processes and the preferences that you
can set for them, see the Sybase CEP Installation Guide. Clicking a link on this tab displays a
chart of the associated information. To clear the display history for a graph, right-click the
graph and then click Clear. Clicking the link again closes the chart.

• Load Limit: Shows the maximum number of adapters or query processors that the
Container process can execute.

• Heartbeat Frequency (sec): Shows the frequency with which the Container notifies the
Manager process that it is running.

• Start Time: Shows when the Container was started.
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• Total Memory (MB): Shows the total amount of memory available to programs for
processing messages on this Container.

• Used Memory (MB): Shows the actual memory reserved by programs on this Container. If
this number reaches the value of the available memory, the program terminates.

• CPU Time (sec): Shows the amount of CPU used by the Container, measured in
milliseconds.

• CPU Utilization (%): Shows the CPU percentage used by the Container, related to all
available processors.

• Server Error Count: Shows the total number of errors in the Sybase CEP Server log for the
Container. This number is reset when the Container starts.

• Server Warning Count: Shows the total number of warnings in the Sybase CEP Server log
for the Container. This number is reset when the Container starts.

• Rcvd Messages: Shows the total number of rows received by queries, but not adapters,
running on the Container during the current Sybase CEP Server session.

• Sent Messages: Shows the total number of rows published by queries, but not adapters,
running on the Container during the current Sybase CEP Server session.

• Discarded Messages: Shows the total number of rows that have been received and then
dropped due to timing or other issues by queries, not adapters, running on the Container
during the current Sybase CEP Server session.

• Pending Messages: Shows the total number of rows in internal buffers waiting to be
processed by queries running on the Container.

• Persistence Messages: Shows the number of state updates waiting to be saved to the disk
on the Container, if you have enabled Persistence.

Query Module Properties
The Properties tab for a query module enables you to view and set project properties.

• Project path shows the location of your project file.
• Module path shows the location of your query module file.
• Accelerated Playback allows you to set the Accelerated playback rate to specify a faster or

slower rate at which the project should be run. The default setting is 1.0, for real time. To
increase the speed, set the number to a value larger than 1.0; to decrease the speed, set the
number to a value smaller than 1.0.
After adjusting the rate, time-based operations are accelerated or decelerated
proportionately. Adjusted-rate playback is only available for applications that use input
files, since the arrival of rows from other kinds of external data sources cannot be adjusted
by Sybase CEP Engine.

• Persistence allows you to determine state persistence for the query module. When you
select the Enable persistence for this module check box, Sybase CEP Server saves
information about the state of the module CCL statements, named windows, data streams,
and adapters to disk at the interval specified in the Commit interval field. This information
can later be used to recover data in case of server failure. You can enable or disable
persistence for every query module individually. You specify the commit interval in CCL
Interval format. See "Time Literals" in the Sybase CEP CCL Reference Guide for more
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information about valid formats. If you enter a positive integer without any further
qualifier, Sybase CEP Engine interprets it as a number of microseconds.
The Properties tab for a query submodule includes the Inherit persistence settings from the
parent module check box. When you select this check box, the submodule uses the same
persistence settings as its parent.
Note that, in cases where a parent module and its submodules specify different commit
intervals, the parent module and all of its submodules use the shortest specified interval.
A data stream always inherits its persistence settings from its query module or submodule.

Warning! Enabling persistence can have a significant negative impact on performance.
• The Synchronization area contains properties that correct synchronization problems in a

module's streams. These settings are automatically inherited by all of the module's input
streams and submodules, but settings for specific streams and submodules can be
overridden, as explained here and in Properties Tab for a Data Stream.
• Selecting Use message timestamp makes available several synchronisation options:

The Maximum delay field allows Sybase CEP Server to correct synchronization
problems among rows arriving in different input streams in a module. When necessary,
Sybase CEP Server retains incoming rows up to the interval specified in the Maximum
delay field, before sorting the order in which they arrive in their respective streams.
Since different streams can have Maximum delay set to different values, the largest
setting of this field among the different streams attached to the module is used to
determine the overall Maximum delay interval for the module. Maximum delay should
not be set to 0.
Selecting Messages can come out of order enables an additional feature that works
with the Maximum out of order delay field, allowing Sybase CEP Server to correct
synchronization problems on a given input stream. When selected, Sybase CEP Server
retains rows arriving in the input stream for the interval specified in the Maximum out
of order delay field, before ordering them by timestamp and delivering them into the
stream. This ensures that any synchronization problems between Sybase CEP Server
and outside data sources encountered in the specified time period are resolved before
the rows are fed into the stream. If the Messages can come out of order check box is not
selected, any row that arrives with an earlier timestamp than the row currently in the
stream is discarded.
The Maximum out of order delay field accepts any valid CCL INTERVAL type, as
described in the Sybase CEP CCL Reference Guide. If you enter a positive integer
without any further qualifier, Sybase CEP Engine interprets it as a number of
microseconds.

Note: Note the difference between Maximum delay and Maximum out of order delay.
The first interval controls synchronization among all of the external input streams in a
module. The second interval controls synchronization only for rows arriving in a single
stream.

• Selecting Use current server timestamp causes rows arriving in a stream to be assigned
a timestamp by Sybase CEP Server, based on the current time. This timestamp
overrides and replaces the timestamp set by the adapter.
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You should use this setting when it is not important to you to know when rows arrive in
the module's streams. With this setting enabled, no rows are marked as arriving out of
order.

• Inherit settings from the parent module sets a submodule’s synchronization options to
those of its parent module.

• The Guaranteed Delivery area contains settings that allow you to specify Guaranteed
Delivery options. These settings are automatically inherited by all of the module's streams,
but settings for specific streams can be overridden, as explained in Setting Data Stream
Properties.

Warning! Guaranteed delivery only works in combination with input or output adapters
that support the Guaranteed Delivery feature, and only if Guaranteed Delivery is enabled
for those adapters. For more information, see the Sybase CEP Integration Guide.
Guaranteed Delivery features by themselves do not guarantee delivery of rows if the
Container process of Sybase CEP Server on which the project is running fails. A
combination of Persistence and Guaranteed Delivery guarantees delivery of rows even in
cases of Container failure.

• Enable guaranteed delivery for this module turns on Guaranteed Delivery, which
guarantees that every row is received by its destination at least once, as long as the
software components are running.

• The Maximum number of messages box specifies the maximum number of messages
to hold in the Guaranteed Delivery queue. Messages that arrive when the Guaranteed
Delivery queue contains this maximum number are discarded. The default setting of 0
(or clearing this box) places no limit on the number of messages in the queue.

• The Maximum message age box specifies the maximum permitted age of messages in
the Guaranteed Delivery queue. Messages that exceed the allowed age are removed
from the queue and discarded. This value is a CCL INTERVAL type, as described in the
Sybase CEP CCL Reference Guide. If you enter a positive integer without any further
qualifiers in this field, Sybase CEP Engine interprets it as a number of microseconds.
Leaving this field blank, or entering 0 in this field, places no limit on the age of
messages in the queue.

Warning! Messages in the Guaranteed Delivery queue are stored in memory. If you do
not place a limit on the size of the queue, or place too high a limit on the queue, you run
the risk of causing Sybase CEP Server to run out of memory.

• Inherit settings from the parent module sets a submodule’s Guaranteed Delivery
options to those of its parent module.

• The Clustering area contains the Number of project instances box, which specifies how
many instances of a project to run. This feature is set from the main query module for all
modules in a project. To use the parallel query feature, set the number of instances for a
project to two or more.

• The Error Recovery area contains the Restart project on failure check box, which allows
you to specify that the project containing the selected query module should automatically
restart following a fatal error.
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Note that adapters are not automatically restarted by selecting this option.

Warning! If the fatal error is not transient, a project set to restart automatically can enter a
continuous restart loop, which can be broken by stopping the project.

Defining a parameter
If your CCL statements uses parameters, the parameters must be defined in the Parameters
table under the Parameters tab, where you can set the name and data type for each parameter.

To define a parameter, enter its name in the Name column and its type in the Type column.

To set a default value for the parameter, specify it in the Default column. This default value
may be overridden by setting the Value column in the Bindings tab, as explained below.

If you need to define more than one parameter, use the Insert row button to the right of the
Parameters table to add extra rows to the Parameters table. To delete unneeded rows, click on
the Delete row button. To move parameter definitions up or down in the Parameters table, use
the Move row up and Move row down buttons.

Binding streams
Use the Bindings tab to create bindings between an input or output data stream and a stream in
another query module, and to override the default values for parameters.
• To bind an input stream to a stream in a parent query module, enter the name of the input

data stream in the Formal Name box of the Input Streams section and the name of the data
stream to which it is bound in the Connection box. When binding an input stream to a
stream in an unrelated module, the Connection specified in the binding must be the full
stream URI. The stream URI is listed in the stream’s properties.

• To bind an output stream to a stream in the project or parent query module, enter the name
of the output data stream in the Formal Name box of the Output Streams section of this tab
and the name of the parent data stream to which it is bound in the Connection box. When
binding an output stream to a stream in an unrelated module, the Connection specified in
the binding must be the full stream URI of the stream. The stream URI is listed in the
stream’s properties.

• Any parameters defined under the Parameters tab also appear in the Parameters section of
the Bindings tab. To override the default value of a parameter, set the value for the
parameter in the Value column on the Bindings tab.

When binding between data streams within a single project, the schema of the stream in the
parent module must be a superset of the schema of the stream in the child module, matching all
columns in the child schema by name and data type.

When binding between data streams in separate projects, Sybase CEP Engine matches the
data based on column name and data type, regardless of number and order. Columns present in
the publishing stream that are not present in the subscribing stream are ignored, while columns
present in the subscribing stream that are not present in the publishing stream are set to NULL.

For example, assume stream A is defined with two columns - Symbol, type String, and Price,
type Long - while stream B is defined in a separate project with three columns - Price, type
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Long; Volume, type Integer; and Symbol, type String. If you bind these two streams together,
with stream A publishing to Stream B, the values from stream A's Symbol and Price columns
are placed in the matching columns of stream B, while stream B's Volume column is set to
NULL. If you bind the streams with B publishing to A, then A receives the values from the
Symbol and Price columns in stream B, while the Volume column is ignored.

Data Stream Properties
A description of data stream properties you can access from the Properties tab in Sybase CEP
Studio.

Stream URI Http URI The URI information for the stream (Note: Http URI is only visible when
the project is running). If multiple instances of the stream are running, the
URI appears with a  ~   #  on the end, where  #  is the number of the

stream instance.

Synchronization Allows you to override the Synchronization settings inherited from the
stream's module. Clear the Inherit settings from the parent module
check box and then set the synchronization properties, which are descri-
bed in Properties Tab. Note that the settings you specify here are valid
only for the specific stream. Only available for an input stream.

Note: Sybase CEP strongly recommends that you set "Use current server
timestamp" at the query module level, not at the stream level, if that is the
synchronization setting you want to use.

Guaranteed Delivery Allows you to override the Guaranteed Delivery options inherited from
the stream's module. Clear the Inherit settings from the parent module
check box and then set the queue size and message age properties, which
are described in Properties Tab. Note that the settings you specify here are
valid only for the specific stream. Only available for an input or output
stream.

Choosing or Creating a Schema file
If you edit the schema of a stream created using Sybase CEP Engine version 5.4 or older, and
the schema is defined in a .ccs file, you can choose a different schema file or create a new
file.

To choose a different schema file:

1. Click the name of the stream in the Explorer view.
2. Click the Open an existing schema file button in the Stream Schema Editor or click CCS

File Editor on the Tools menu.
3. Navigate to the file you want to use and then click Open. The Stream Schema Editor now

shows the contents of the file you opened.

Note that, if you edit a schema definition file that is used by more than one stream, the schema
changes for all of the associated streams.
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To create a new schema file:

1. Click the name of the stream in the Explorer view.
2. Click the Create a new schema button in the in the Stream Schema Editor.
3. Navigate to the directory where you want to create the new schema file and then enter a

name for the file into the Filename box.
4. Click Save. The Stream Schema Editor now shows a blank schema.
5. Use the Insert row button to add a column to the schema, and then enter the name and type

of a column.
6. Define additional columns as needed. Use the Insert row button to add a column, the Delete

row button to delete a column, and the Move row up and Move row down buttons to move
column definitions up and down in the editor.

Window Properties
A description of properties you can set from the Properties tab for a named window.

Window URI Http
URI

The URI information for the window (Note: Http URI is only visible when the
project is running). If multiple instances of the window are running, the URI
appears with a  ~   #  on the end, where  #  is the number of the window
instance.

Window Policies The KEEP clauses in the window definition.

Public If selected, this window is public. See "Public Windows" in the Sybase CEP
CCL Reference Guide for more information.

Master/Mirror Specifies whether this window is a Master window, a Mirror window, or
neither. If you specify Master, you can specify columns for filtering purposes.
If you specify Mirror, you must also identify the associated master window
and, optionally, values for filter columns. For a Mirror window, you can also
enter an arbitrary expression into the Filter by Expression box. See "Shared
Windows" in the Sybase CEP CCL Reference Guide for more information.

Removed Rows Des-
tination

The stream or window in the current query module that receives rows re-
moved from this window. See "CREATE WINDOW Statement" in the Syb-
ase CEP CCL Reference Guide for more information.

Schema Properties
The schema editor lets you modify a schema.

You can:

• Change the name or data type of any column by entering a new name or type.
• Use the Insert row button to add a column to the schema, then enter the name and data type

for the column.
• Use the Delete row button to delete a column and the Move row up and Move row down

buttons to move column definitions up and down in the editor.
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Adapter Properties
Every type of input and output adapter has properties that you must set for the adapter to
function properly.

Examples include the rate at which an adapter should process data, the source from which the
adapter obtains data, or the destination to which it delivers data. Some properties are unique to
a particular type of adapter. When you click the name of an adapter in the Explorer view, the
Properties tab of the Properties view displays the associated properties. Some labels in the
Properties tab act as links, displaying or hiding a help summary for the associated property.
For additional instructions on setting properties for specific adapter types, see the Sybase CEP
Integration Guide.

Status View
A description of the Status View in Sybase CEP Studio.

By default, the Status view appears only when a project is running.

The Status tab displays information about the running project selected in the Explorer view.

The Metrics tab displays information from the Status Stream related to the running project
selected in the Explorer view.

Status Tab
A description of the Sybase CEP Studio components you can view statuses for from the Status
Tab.

Note that some labels on this tab are links, displaying or hiding a graph of the associated data.

Table 1. Workspace-Name/Project-Name

Name Description

Status The project's status, either "Running" or "Stopped".

Started At The date and time when the project was last started.

Uptime
The length of time the project last ran, or has been running
since it was started.

Queries Used Memory (MB)

The total memory usage for all queries in the project.

Note that this calculation is not exact. For example,
memory in buffers used by all running projects is not
included as part of the total, and memory used by a row
that appears in multiple windows is counted multiple
times. Also note that the preference "SybaseC8/Perform-
ance/EnableMemoryUsageStats" in the file c8-serv-
er.conf controls whether or not this statistic displays.
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Name Description

Queries CPU Utilization(%)
The CPU utilization of the project's queries, as a percent-
age of total capacity on all available processors.

Table 2. Containers

Name Description

(unnamed)
A list of URIs for the Containers, including host names
and port numbers.

Used/Total Memory (MB)
The amount of memory used by the selected Container
and the total memory available for use by the Container.

CPU Utilization (%)
Container CPU utilization, as a percentage of total ca-
pacity on all available processors.

Table 3. Messages

Name Description

Avg End-to-End Latency
The average interval between the time a row arrives to be pro-
cessed by an input adapter and the time it is completely pro-
cessed by an output adapter.

Avg Queries Latency

The average interval between the time a row arrives in the
project and the time it is processed by all the CCL statements
and submodules in the project. (Average queries latency does
not count the time it takes for rows to be processed by adapt-
ers.)

Received
The total number of rows and average number of rows per
second received by the project's queries since it started run-
ning.

Sent
The total number of rows and average number of rows per
second published by the project's queries since it started run-
ning.

Discarded The number of rows discarded by the project.

Pending The number of rows pending processing by the project.

Pending Persistence
The number of rows in a Persistence-enabled project waiting to
be saved to disk. This number is always 0 for non Persistence-
enabled projects.
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Name Description

RPC/DB Pending
The number of rows awaiting a response from a remote pro-
cedure or function.

RPC/DB Cached
The number of rows cached by the project's database subqu-
eries and remote subqueries.

Metrics Tab
The Metrics tab displays a table of Status Stream information, filtered for the selected running
project.

Use the Save button to save the table to a file in CSV format.

Use the Copy button to copy the table to the clipboard.

For a description of the messages displayed in the table, see "Sybase CEP Server Events" in
the Sybase CEP Installation Guide.

Note that you can view the complete Status Stream by clicking Open Workspace Status
Stream on the Debug menu.

Flow View
The Flow view displays a flow diagram of your project and all of its components.

Viewing Project Data Flow in the Flow View
The Flow view displays an interactive diagram of a project, or one of its modules, and all of the
associated components. The Flow view shows the relationships between all the components,
including CCL statements and submodules, data streams and adapters, and external databases.

The following table describes the graphic elements of the Flow view:

 Input and output adapters.

External databases.

 Input, output, and local streams. Right-clicking a stream allows you to open a viewer
for that stream.

 
Regular and public named windows. Right-clicking a named window allows you to
open a viewer for that window.

CCL statements inside the current module. Each blue box represents a separate CCL
statement. A portion of the statement text appears inside the box.
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Submodule of the current query module.

The Flow view also displays:

• The number of rows processed by each of the module's CCL statements since the project
was last started.

• The average latency to each data stream (number of microseconds it takes rows to travel
from any input adapter to the stream).

• The average latency from each data stream (number of microseconds it takes rows to travel
from the stream to any output adapter).

• The size of each window.
• The approximate amount of memory used by each window.
• The approximate amount of memory used by each query (note that the preference

"SybaseC8/ Performance/ EnableMemoryUsageStats" in the file c8-server.conf controls
whether or not the memory statistics display).

These run-time statistics can be turned on and off by clicking Show Runtime Information on
the View menu.

Right-clicking a group of CCL statements in the Flow view shows the statements' detail.
Right-clicking other objects displays the same shortcut menu as when you right-click the same
component in the Explorer view.

Navigating the Flow View
The Flow view updates dynamically as you modify your CCL or add or remove adapters and
streams.

Clicking any component of your project in the Explorer view selects the component in the
Flow view, and double-clicking any component in the Flow view, except an external database,
causes its information to be displayed in the Explorer, Editor, and Properties views.
Furthermore, if a query module includes nested submodules, double-clicking the submodule's
icon in the Flow view displays a detailed view of the submodule's contents.

Changing the Flow View Display
Inside the Flow view, you can move project and query module components manually by
dragging a component to create a different layout.

Moving the components of the module in the Flow View does not change their configuration
or the flow of the data in the project or module. The new layout appears in the Flow view until
one of the following events resets the view to its default layout:

• You add, remove, or rename a data stream, named window, submodule, or adapter.
• You change the contents of a query module.
• You click the Automatic Layout button in the Flow view toolbar, or click Automatic Flow

View Layout on the View menu.

User Interface

Studio Guide    31



The Flow view toolbar includes several other buttons used to control the display. See Flow
View Toolbar on page 19 for more information.

Output View
The Output view displays compilation and execution messages.

The Compilation tab displays messages when you compile a project.

Note: You can double-click an error message in the Output view to go to the source of the error
message in your CCL code.

The Execution tab displays messages related to running a project and to Sybase CEP Studio
operations, such as connecting to a Workspace.

Stream and Window Viewers
A stream viewer displays rows as they arrive on the stream. A window viewer displays the
current contents of the window as rows enter and are removed from the window.

New rows are shown in red and are marked with a red dot. If you have selected the Show
deleted rows check box in the Stream Viewer tab of Studio Settings on page 38, rows that
have just been removed from the window are shown crossed out until the window contents
change again.

See Using Viewers to Debug an Application on page 34 for more information on debugging
in viewers.

See Copying Data from a Viewer on page 34 for information on copying values or rows from
a stream or window viewer.

Filtering Data in a Viewer
A description of how to filter data in a viewer, and specify filter columns and filter expressions.

Display
To filter the display in a viewer, enter a string into the Show only box at the bottom of the
viewer. The viewer display is limited to rows that contain the specified string in any column,
regardless of data type. Clear the display filter by deleting the string in the text box or by
clicking the red x to the right of the box. Note that this feature only affects the display, not the
contents of the stream or window.

Subscription
You can restrict the rows reaching the stream or window viewer by specifying filter columns, a
filter expression, or both.
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Filter Columns
If you are viewing an output stream or master window for which the FILTERCOLUMNS
property has been set, you can specify parameters for the URI that limit the subscription to
rows matching the specified filter values. For more information about FILTERCOLUMNS,
see "CREATE STREAM Statement" and "CREATE WINDOW Statement" in the Sybase
CEP CCL Reference.

To use this feature, follow these steps:

1. Enter a comma-separated list of values in the Filter Columns box in the viewer. The values
must be in the order specified by the FILTERCOLUMNS property of the output stream.

2. Click the Reconnect button to the right of the URI. Sybase CEP Studio reconnects to the
stream, passing the filter values as query string parameters. The viewer now displays only
those rows with columns containing the specified values.

Filter Expression
Enter an expression into the Filter Expression box to limit the subscription to those rows for
which the specified expression evaluates as True, even if the stream or master window does not
have the FILTERCOLUMNS property set.

Any standard CCL Boolean scalar expression can be specified, but it cannot include any of the
following:

• Aggregator functions, such as SUM() or COUNT().
• Stateful operators like PREV().
• FIRST / LAST / INDEX operators.
• CCL variable references.
• GETTIMESTAMP().
• GET__COLUMNBYNAME().
• XMLPATTERNMATCH().
• Functions used within XMLTABLE().

However, you can include user-defined scalar functions and the zero-argument variant of
GETTIMESTAMP(). For information, see the Sybase CEP CCL Reference Guide.

You can also specify filter column values and/or a filter expression when you open a new
viewer by clicking View Stream on the Debug menu.

Note that these features filter rows before Sybase CEP Studio displays them in the viewer, but
the filter only applies to the viewer and does not affect any other component of your project.
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Searching for Data in a Viewer
A description of how to search for the occurrence of specific data in a viewer using search
fields.

1. Click the Find button on the viewer toolbar.

2. Enter the search criteria in the Find box.

3. Select the Match case check box if you want the search to take upper and lower case into
account.

4. Select the Match whole word check box if you only want to search for whole words.

5. Click Find Next to find the next occurrence of the pattern you specified, or Mark All to
search for and mark all occurrences of the pattern.

Copying Data from a Viewer
A description of how to copy data from a viewer. Provides an example of the output format of
copied data.

Copying
• Copy a String or XML column value to a file: Right-click the column value and then click

Show value. Sybase CEP Studio saves the value to a file under tmp/values in the
SybaseC8Repository and then opens that file with the default CSV editor you specify in
the External Tools tab of the Settings window on page 37.

• Copy rows to the clipboard: Select the rows of interest (right-click and then click Select All
to select the entire contents of the viewer), right-click, and then click Copy.

• Copy rows to a file: Select the rows of interest, right-click, and then click Save to File.

Output Format
Copied rows include a heading row with column names and an initial column containing the
row timestamp. This example shows the results of copying a row containing two columns:

Timestamp,Id,Data
1087491625647388,54,76

Null values are ignored. Timestamps appear in the format you specify in the Stream Viewer
tab of the Settings window on page 37.

Using Viewers to Debug an Application
Sybase CEP Studio viewers have a step-through feature that you can use as an aid to debug
applications. It helps you to track when rows arrive in different streams within a specified
interval.

To use the debug features effectively, follow these steps:
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1. Open viewers for all the streams and named windows you want to analyze.

2. Pause the viewers.

3. Choose a viewer (called the primary viewer in these instructions) displaying rows with
timestamps from which you will start tracking.

4. Decide whether you want to track forward or backward from the timestamp of a specific
row and then click a row with the appropriate timestamp in the primary viewer.

5. Click either the Step Forward or Step Backward button on the viewer toolbar (or click
either Step Forward or Step Backward on the Debug menu).

• Step Forward selects all rows in all viewers with a timestamp equal to or greater than
the timestamp of the selected row in the primary viewer, but no greater than the
timestamp of the subsequent row in the primary viewer. The viewers display selected
rows in red, with a red dot to their left. If you click one of these rows, the dot changes to
purple and the text changes to black.

• Step Backward selects all rows in all viewers with a timestamp no greater than the
timestamp of the selected row in the primary viewer, but greater than or equal to the
timestamp of the previous row in the primary viewer. The viewers display selected
rows in red, with a red dot to their left. If you click one of these rows, the dot changes to
purple and the text changes to black.

6. Click the Timestamp column heading to toggle between new rows being inserted at the top
of the viewer and new rows being inserted at the bottom of the viewer.
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Sybase CEP Studio Settings

An overview of functions that you can access through the Sybase CEP Studio Settings.

Sybase CEP Studio Settings: External Tools Tab
A description of functions you can access from the External Tools tab under Sybase CEP
Studio Settings.

XML Viewer This application is used to display XML files.

CSV Editor This application is used to edit CSV files.

PDF Viewer This application is used to display PDF files and is only changeable on UNIX-
like operating systems.

java.exe command
path

The location of the Java executable. Required for the BPEL to CCL Wizard.

Sybase CEP Studio Settings: General Tab
A description of functions you can access from the General tab under Sybase CEP Studio
Settings.

Repository The location of the Sybase CEP Repository. The Repository is where
Sybase CEP Studio stores its configuration files, temporary files, and
examples, as well as being the default location for new projects. Click the
button to the right of the field to change the location of your Repository.

Adapters' Base Folder The directory Sybase CEP Studio opens when you are browsing for the
data file to use with an adapter. For more information about the adapters
base folder, see "Configuring Sybase CEP Adapters" in the Sybase CEP
Integration Guide.

Check Sybase CEO
news on start-up

Whether or not you want to see important Sybase CEP updates and
notifications when you start Sybase CEP Studio.
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Sybase CEP Studio Settings: Query Editor Tab
A description of functions you can access from the Query Editor tab under Sybase CEP Studio
Settings.

Font The font family and point size of the text in the Queries tab of the
Editor view.

Display Item The colors and font styles for various items displayed in the Queries
tab.

Disable keyword/field-se-
lection autocomplete

If selected, disables the autocomplete feature, which automatically
completes partial word entries in the Queries tab.

Keyword minimum length
for autocomplete

The minimum number of characters you must enter to trigger the
autocomplete feature.

Disable projects tree and
editor synchronization

Controls whether or not Sybase CEP Studio scrolls to the statement
that creates a component in the Queries tab when you select the
corresponding component in the Explorer view, and vice versa. This
feature affects only scrolling: it does not affect synchronization be-
tween the Explorer view and the Flow view. Any CCL statements
associated with a component selected in one of these views is also still
highlighted with a green line in the Queries tab margin, whether or not
this feature is enabled.

Disable automatic $Project-
Folder use

When you use the Sybase CEP Studio user interface to locate the file
to use with an adapter, it automatically specifies the file name relative
to "$ProjectFolder", if possible. If you check this setting, Sybase CEP
Studio will instead use the absolute path or "$BaseFolder" in the path
to the file.

Sybase CEP Studio Settings: Stream Viewer Tab
A description of functions you can access from the Stream Viewer tab under Sybase CEP
Studio Settings.

Rows to display The maximum number of rows viewers can display at any given time.
For viewing windows, set this number to at least twice the number of
rows retained by the window. Otherwise the viewer may display
inaccurate data.

Timestamp format A format for displaying row timestamps. For more information, see
"Timestamp Format Codes" in the Sybase CEP CCL Reference
Guide.

Timestamp timezone The time zone for displaying row timestamps.
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Show timestamp column Whether or not the timestamp column is displayed.

Show deleted rows Whether or not rows that have just been deleted from a named win-
dow appear in the viewer. If selected, deleted rows appear crossed out
when they are first deleted, then disappear from the viewer when the
CCL statement executes again.

Rows coloring The background color for rows, either None for all white, or Zebra for
alternating between white and gray after the specified number of
rows.

New messages are appen-
ded to the

Where new rows appear in a viewer, either Top or Bottom.

Setting the Compiler Options
A description of features you can set from Compiler Options in the Project Menu of the
Explorer view.

To set or view compiler options for a project, click the name of the project in the Explorer view
and then click Compiler Options on the Project menu:

• Project path displays the location of the project file.
• Project name displays the name under which the project was loaded into the Workspace.

Note that a project can be loaded several times under different names (by clicking the
project in the Explorer view and then clicking Rename in the shortcut menu).

• Workspace name displays the Workspace containing the project.
• Compiler Mode (also available on the Compile toolbar on page 18) specifies either Debug

mode, which allows the contents of local streams and named windows to be displayed in
stream and window viewers, or Release mode, which does not.

• Max Errors Reported limits the number of errors the compiler reports to the specified
value.

• Eliminate redundant primitives improves performance by attempting to eliminate
redundancy in the low-level engine primitives generated by the compiler. Leave this option
enabled unless asked to disable it by Technical Support.

• Evaluate WHERE and HAVING as soon as possible reduces resource requirements,
because fewer rows are entered into time-based windows and their associated indexes, and
fewer cross-products are calculated.

• Shortcut AND and OR operators stops evaluating AND and OR subclauses as soon as they
become irrelevant: AND subclauses when one of their components evaluates to FALSE;
OR subclauses when one of their components evaluates to TRUE. Leave this option
enabled, unless asked to disable it by Technical Support

• Remove internal streams improves performance by eliminating some streams from the
compiled version of the CCL file and preventing them from being created on Sybase CEP
Server when the project is run. Streams are removed unless one or more of the following
conditions is true:
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• Debug mode is turned on.
• The Remove internal streams check box is not selected.
• The stream is an input stream.
• The stream is an output stream that has no binding to a stream in a parent module.
• The stream is attached to an adapter.
Note that the Explorer view continues to display removed streams. You can also open a
stream viewer for a removed stream, but the viewer is empty.

• Suppress all warnings suppresses all warning messages.
• Warn when indexes are not used generates a warning when CCL execution is likely to be

slow because an index between two or more data sources in a CCL statement could not be
created or deduced.

• Issue deprecation warnings generates a warning when your project includes deprecated
CCL syntax.

• Issue warnings for implicit string conversions generates a warning whenever a CCL data
type within the current project is automatically converted into a STRING data type, or
from a STRING to another data type.

• Issue warnings for data sources that are used in queries but receive no input generates a
warning whenever a data source used in a CCL statement is not set to receive data through
another statement or subquery, a stream binding, or an adapter.

• List of folders to search for imported files allows you to enter the names of directories
where you want the compiler to search for files that you import into your project. List each
directory on a separate line, and the compiler searches the directories in the listed order.
For a complete discussion of this compiler option, see "Compiling Directly via the CCl
Compiler" in the Sybase CEP Integration Guide, under "Importing."

Sybase CEP Studio Settings

  40 Sybase CEP Option  



Index
B
Bindings Tab 25

Bindings Tab 25
BPEL

Sybase CEP Studio Settings: External Tools
Tab 37

C
Changing Flow View Display 31
Compile

Compile Toolbar 18
Compiler Options

Compiler Options 39
Compiling, from Sybase CEP Studio

Sybase CEP Studio and Sybase CEP Server 1
Components of

Project Components 4
Copying Data from

Displaying a Column Value 34
Creating, in Sybase CEP Studio

Project Menu 13
CSV Editor

Sybase CEP Studio Settings: External Tools
Tab 37

D
Debug

Debug Menu 14
Debug Menu

Debug Menu 14
Defining, in Sybase CEP Studio

Project Menu 13

E
Edit Menu

Edit Menu 11
Editing Query Module Properties 22
Editing, in Sybase CEP Studio

Editor View 20
Editor

Editor Toolbar 18
Editor View 20

Editor View 20
Editor View 20

Environment
Sybase CEP Studio and Sybase CEP Server 1

Explorer
Explorer View 20

External Tools Tab
Sybase CEP Studio Settings: External Tools

Tab 37

F
File

File Menu 10
File Menu

File Menu 10
Filtering Data in

Filtering Data in a Viewer 32
Flow

Flow View 30
Flow View

Flow View Toolbar 19

G
General

Sybase CEP Studio Settings: General Tab 37

H
Help

Help Menu 16
Help Menu

Help Menu 16

I
in Sybase CEP Studio

Bindings Tab 25
Compile Toolbar 18
Compiler Options 39
Debug Menu 14

Index

Studio Guide    41



Edit Menu 11
Editor Toolbar 18
Editor View 20
Explorer View 20
File Menu 10
Flow View 30
Flow View Toolbar 19
Help Menu 16
Module Toolbar 18
Output View 32
Parameters Tab 25
Project Menu 13
Properties View 21
Shortcut Menu 17
Status View 28
Stream Viewer Toolbar 19
Sybase CEP Studio and Sybase CEP Server 1
Sybase CEP Studio Settings: External Tools

Tab 37
Sybase CEP Studio Settings: Query Editor Tab

38
Tools Menu 16
View Menu 12

in Sybase CEP Studio Status View
Metrics Tab 30

in Viewer
Stream or Window Viewer Toolbar 19

Interaction with Sybase CEP Server
Sybase CEP Studio and Sybase CEP Server 1

L
Loading, from Sybase CEP Studio

Sybase CEP Studio and Sybase CEP Server 1

M
Menus, Sybase CEP Studio

Sybase CEP Studio Interface 7
Metrics Tab 30
Module

Module Toolbar 18
Monitoring Status, in Sybase CEP Studio

Monitoring Sybase CEP Server 21
Monitoring Sybase CEP Server 21

N
Navigating the Flow View 31

O
Output

Output View 32

P
Parameters Tab 25

Parameters Tab 25
PDF Viewer

Sybase CEP Studio Settings: External Tools
Tab 37

Project
Project Menu 13

Project Components 4
Project Menu

Project Menu 13
Properties

Properties View 21
Viewing and Changing Adapter Properties 28

Properties Tab
Properties Tab for a Data Stream 26

Properties Tab for a Data Stream 26
Properties, Setting in Sybase CEP Studio

Editing Query Module Properties 22

Q
Queries Tab

Editor View 20
Query Editor

Sybase CEP Studio Settings: Query Editor Tab
38

Query Module
Project Components 4

R
Row

Project Components 4
Running, from Sybase CEP Studio

Sybase CEP Studio and Sybase CEP Server 1

S
Schema Properties 27

Index

  42 Sybase CEP Option  



Schema Properties 27
Schema Tab 26
Searching in

Searching for Data in a Viewer 34
Setting, in Sybase CEP Studio

Properties Tab for a Data Stream 26
Settings

Sybase CEP Studio Settings: External Tools
Tab 37

Settings in Sybase CEP Studio
Sybase CEP Studio Settings: Stream Viewer

Tab 38
Settings, General

Sybase CEP Studio Settings: General Tab 37
Settings, Query Editor

Sybase CEP Studio Settings: Query Editor Tab
38

Settings, Stream Viewer
Sybase CEP Studio Settings: Stream Viewer

Tab 38
Shortcut

Shortcut Menu 17
Status

Status Tab 28
Status View 28

Status Tab 28
Monitoring Sybase CEP Server 21

Stream Viewer
Stream Viewer Toolbar 19
Sybase CEP Studio Settings: Stream Viewer

Tab 38
Sybase CEP Studio and Sybase CEP Server 1
Sybase CEP Studio Menus

Sybase CEP Studio Interface 7
Sybase CEP Studio Toolbars

Sybase CEP Studio Interface 7
Sybase CEP Studio Views

Sybase CEP Studio Interface 7

T
through Sybase CEP Engine

Project Components 4

Toolbars, Sybase CEP Studio
Sybase CEP Studio Interface 7

Tools
Tools Menu 16

Tools Menu
Tools Menu 16

U
User Interface

Sybase CEP Studio Interface 7
Using Viewers to Debug an Application 34

V
View

View Menu 12
View Menu

View Menu 12
Viewer

Using Viewers to Debug an Application 34
Viewer, Copying Data from

Displaying a Column Value 34
Viewer, Filtering Data in

Filtering Data in a Viewer 32
Viewer, in Sybase CEP Studio

Sybase CEP Studio Interface 7
Viewer, Searching in

Searching for Data in a Viewer 34
Viewers, in Sybase CEP Studio

Searching for Data in a Viewer 34
Viewing and Changing Adapter Properties 28
Viewing Project Data Flow in the Flow View 30
Views, Sybase CEP Studio

Sybase CEP Studio Interface 7

X
XML Viewer

Sybase CEP Studio Settings: External Tools
Tab 37

Index

Studio Guide    43



Index

  44 Sybase CEP Option  


	Studio Guide
	Contents
	Overview
	Sybase CEP Studio Overview
	Sybase CEP Studio and Sybase CEP Server
	Downloading Sybase CEP Studio
	Installing Sybase CEP Studio

	Project Components and Data Flow

	User Interface
	Sybase CEP Studio Interface
	Sybase CEP Studio Main Window
	Status View Layout
	Stream or Window Viewer

	Menus
	File Menu
	Edit Menu
	View Menu
	Project Menu
	Debug Menu
	Tools Menu
	Help Menu
	Shortcut Menu

	Toolbars
	Module Toolbar
	Editor Toolbar
	Compile Toolbar
	Stream Viewer Toolbar
	Flow View Toolbar
	Stream or Window Viewer Toolbar

	Views
	Explorer View
	Editor View
	Properties View
	Displaying the Sybase CEP server status
	Query Module Properties
	Defining a parameter
	Binding streams

	Data Stream Properties
	Choosing or Creating a Schema file

	Window Properties
	Schema Properties
	Adapter Properties

	Status View
	Status Tab
	Metrics Tab

	Flow View
	Viewing Project Data Flow in the Flow View
	Navigating the Flow View
	Changing the Flow View Display

	Output View

	Stream and Window Viewers
	Filtering Data in a Viewer
	Display
	Subscription
	Filter Columns
	Filter Expression


	Searching for Data in a Viewer
	Copying Data from a Viewer
	Copying
	Output Format

	Using Viewers to Debug an Application


	Sybase CEP Studio Settings
	Sybase CEP Studio Settings: External Tools Tab
	Sybase CEP Studio Settings: General Tab
	Sybase CEP Studio Settings: Query Editor Tab
	Sybase CEP Studio Settings: Stream Viewer Tab
	Setting the Compiler Options

	Index


